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3. Design
3.1. Skizzenerstellung

3.1.1 Skizzenschnittansicht

In der Anwendung „Skizzen-Aufgabenumgebung“ können Sie eine Schnittansicht eines Teils anzeigen,
um die inneren Details und Maße beim Skizzieren besser visualisieren zu können. Als Schnittebene
wird automatisch die Skizzenebene verwendet. Sie können auch eine Scheibe Ihrer Schnittansicht
anzeigen oder die Schnittansicht automatisch umkehren, wenn Sie Ihr Modell drehen.

Anzeigen einer Schnittansicht

 Schnitt
Um das Innere Ihres Teils auf der Skizzenebene zu sehen, zeigen Sie mit dem Befehl Schnitt (Section)
eine Schnittansicht Ihres Teils an.
In diesem Beispiel wird der Befehl Skizzenhervorhebung (Sketch Emphasis) verwendet, um die aktive
Skizze hervorzuheben.

Aufteilen der Schnittansicht in Schichten

 Schicht
Um beim Skizzieren eine Schicht Ihres Teils anzuzeigen, verwenden Sie die Option Schicht (Slice).
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Umkehren einer Schnittansicht

 Schnittrichtung automatisch umkehren
Möchten Sie die Skizzenschnittrichtung automatisch umkehren, wenn Sie Ihr Modell drehen,
verwenden Sie die Option Schnittrichtung automatisch umkehren (Auto Reverse Section Direction).

Wo kann diese Funktion aufgerufen werden?

Anwendung Skizzen-Aufgabenumgebung

Menübandleiste

Registerkarte Startseite (Home) → Gruppe Skizze (Sketch) → Schnitt (Section)
Registerkarte Startseite (Home) → Gruppe Skizzenschnitt (Sketch Section) →

Schicht (Slice) 
Registerkarte Startseite (Home) → Gruppe Skizzenschnitt (Sketch Section) →

Schnittrichtung automatisch umkehren (Auto Reverse Section Direction) 
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3.1.2 Erzeugen von Ausrichtungszwangsbedingungen

Steuern Sie mithilfe des Anwenderstandards Ausrichtungszwangsbedingungen erzeugen (Create
Alignment Constraints), ob die Zwangsbedingungen Horizontale Ausrichtung (Horizontal Alignment)

 und Vertikale Ausrichtung (Vertical Alignment)  automatisch ermittelt werden, wenn Sie
Kurven erzeugen.

In diesem Beispiel wird ein zweiter Kreis rechts vom linken Kreis platziert. Beachten Sie, dass der
Mittelpunkt des zweiten Kreises so einrastet, dass er mit dem ersten Kreis horizontal ausgerichtet ist.
Eine horizontale Zwangsbedingung wird jedoch nur automatisch ermittelt, wenn der
Anwenderstandard Ausrichtungszwangsbedingungen erzeugen (Create Alignment Constraints)
festgelegt ist.

 Ausrichtungszwangsbedingungen erzeugen  Ausrichtungszwangsbedingungen erzeugen

Wenn Ausrichtungszwangsbedingungen erzeugen (Create Alignment Constraints) aktiviert ist, können
Sie Ausrichtungszwangsbedingungen im Dialogfenster Ermittelte Zwangsbedingungen und
Bemaßungen (Inferred Dimensions and Constraints) manuell deaktivieren. Wenn der
Anwenderstandard deaktiviert ist, werden die Optionen Horizontale Ausrichtung (Horizontal) und
Vertikale Ausrichtung (Vertical Alignment) in dem Dialogfenster nicht angezeigt.

Wann wird diese Funktion verwendet?

Sie können steuern, ob horizontale und vertikale Ausrichtungszwangsbedingungen automatisch
ermittelt werden, wenn Sie Kurven erzeugen. Standardmäßig ist der Anwenderstandard
Ausrichtungszwangsbedingungen erzeugen (Create Alignment Constraints) deaktiviert und werden
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während der Kurvenerzeugung keine Ausrichtungszwangsbedingungen automatisch ermittelt. In NX
11 wurden die horizontalen und vertikalen Ausrichtungszwangsbedingungen standardmäßig
automatisch ermittelt.

Wo kann diese Funktion aufgerufen werden?

Anwendung Skizze

Vorraussetzungen Der Anwenderstandard Ausrichtungszwangsbedingungen erzeugen
(Create Alignment Constraints) muss aktiviert sein.

Befehlssuche Ermittelte Zwangsbedingungen und Bemaßungen

Position im Dialogfenster Horizontale Ausrichtung
Vertikale Ausrichtung

3.1.3 Skizzenhervorhebung

Verwenden Sie den Befehl Skizzenhervorhebung (Sketch Emphasis), um schnell das aktive Teil zu
kennzeichnen, wenn Sie in der Skizzen-Aufgabenumgebung im Baugruppenkontext eine Skizze
erzeugen. Dieser Befehl verbessert und ersetzt den Befehl Arbeitsebene hervorheben (Work Plane
Emphasis) in der Skizzen-Aufgabenumgebung, der zwar die Farben aller Objekte, die sich nicht auf
der Skizzenebene befinden, blasser darstellt, das aktive Teil aber nicht kennzeichnet.

Skizzenhervorhebung aktiviert Arbeitsebene hervorheben ist aktiviert

Wann wird diese Funktion verwendet?

Sie können den Befehl verwenden, um schnell zu erkennen, in welchem Teil Sie eine Skizze erstellen.
Dadurch können Sie vermeiden, unbeabsichtigte WAVE-Verknüpfungen zu erstellen, und zuverlässig
das richtige aktive Teil auswählen, bevor Sie eine Skizze erzeugen.

Wo kann diese Funktion aufgerufen werden?

Anforderung: Sie müssen sich in der Skizzen-Aufgabenumgebung befinden.
Befehlssuche: Skizzenhervorhebung
Menübandleiste: Registerkarte „Startseite“ → Gruppe „Skizze → Skizzenhervorhebung
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3.1.4 Verwenden von mehreren Fenstern bei Skizzenerstellung

Wenn Sie in der Skizzen-Aufgabenumgebung und in Direkte Skizze (Direct Sketch) arbeiten, können
Sie jetzt mehrere Teile gleichzeitig in separaten Registerkartenfenster anzeigen.

Wenn die Komponente, die Sie gerade bearbeiten, in beiden Fenstern angezeigt wird, werden Ihre
Änderungen automatisch in beiden Fenstern angewendet.

In diesem Beispiel ist ein Teil auf der linken Seite und dessen übergeordnete Baugruppe auf der
rechten Seite geöffnet. Sie können die Aktualisierungen am Teil auf der rechten Seite anzeigen,
während Sie die Skizze erzeugen oder bearbeiten.

Wenn Sie eine Skizze in mehreren Registerkartenfenstern erstellen, können Sie Folgendes
durchführen:

Erzeugen Sie in einem separaten Fenster Komponenten aus der Baugruppe. Bei dieser Methode
können Sie nur die neue Komponente anzeigen, ohne dass die anderen Komponenten manuell
ausgeblendet werden müssen.
Referenzieren Sie eine Komponente, um schnell eine ähnliche Skizze in einem separaten
Fenster zu erstellen, da beide Komponenten gleichzeitig angezeigt werden.
Ändern Sie Komponenten in einem einzigen Fenster. Die Änderungen werden automatisch in
allen Fenstern nachgezogen, in denen diese Komponente angezeigt wird.

Hinweis:
Wenn Sie die Skizze direkt in Konstruktion erzeugen, haben Sie folgende Möglichkeiten:
→ Sie können das Mausrad halten und ziehen oder den Spaceball verwenden, um in ein anderes
Registerkartenfenster zu wechseln.
→ Sie können die Skizze schnell deaktivieren, indem Sie in ein anderes Registerkartenfenster
klicken.

Wo kann diese Funktion aufgerufen werden?
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Anwendung: Konstruktion
Vorraussetzung: Sie müssen mehrere Teile geöffnet haben.

Menübandleiste:
Registerkarte Datei (File) → Fenster (Window) → Fensterlayout (Window Layout) →
Auf der Basis der gewünschten Anordnung und der Anzahl der Teile, die
gleichzeitig angezeigt werden sollen, einen Befehl auswählen

3.2. Konstruktion

3.2.1 Neue Konstruktionsbefehle

3.2.1.1 KSYS drucken

Beim Konstruieren eines Modells können Sie den neuen Befehl KSYS drucken (Print CSYS) verwenden,
um ein Koordinatensystem zu erstellen, mit dem die Druckrichtung definiert wird, die später beim 3D-
Drucken verwendet wird.

Sie können die Orientierung des Befehls „KSYS drucken“ manuell definieren oder Sie können es NX
überlassen, eine Orientierung vorzuschlagen, die ein erhebliches Glätten des Teils bewirkt, wenn es
gedruckt wird. Das Ergebnis ist ein neues KSYS-Formelement, das so positioniert ist, dass das Teil auf
der XY-Ebene aufliegt und die Erstellungsrichtung in der +Z-Richtung ausgerichtet ist.

(1) Absolutes Bezugs-KSYS, das bei Modellerstellung verwendet wird
(2) KSYS für Drucken ist so ausgerichtet, dass das Teil zum Drucken geglättet wird

Mit den folgenden Befehlen können Sie jetzt auch ein Druckkoordinatensystem zu einem Modell
hinzufügen:

Eingeklemmte Stützen prüfen
Maximalen Überlappungswinkel prüfen
Druckbares Volumen prüfen

In diesen Fällen fügt NX dem Modell ein neues KSYS zum Drucken hinzu und bestimmt dessen
Platzierung mithilfe des aktuell angegebenen Konstruktionsebenen-KSYS.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion, Fertigung
Befehlssuche: KSYS drucken

http://chriscomp.de/dokuwiki/lib/exe/fetch.php?media=nx1202_nx_design_023.png
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3.2.1.2 Körper durch Gleichung

Verwenden Sie den Befehl Körper durch Gleichung (Body by Equation), um komplexe, mathematisch
definierte Oberflächen als konvergente Facettenkörper aus Symbolica in NX zu importieren.

Das neue NX-Formelement ist mit dem zugehören Symbolica-Ausgangsarbeitsblatt und der STL-
Ausgabedatei des 3D-Plots verbunden. Mit jeder Änderung am Symbolica-Arbeitsblatt wird der
verknüpfte NX-Facettenkörper aktualisiert.

Sie können Symbolica-Ausgangsarbeitsblätter aus den folgenden Positionen importieren:

Einem Verzeichnis im Betriebssystem.
Einer Teamcenterposition
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Eine Symbolica-Arbeitsblatt, das zuvor in der NX-Teiledatei eingebettet war.

Wann wird diese Funktion verwendet?

Verwenden Sie den Befehl Körper durch Gleichung (Body by Equation), wenn Sie
gleichungsgesteuerte Körper und Flächen in Anwendungen benötigen, die die Gesetze der Physik in
ihre Konstruktionen integrieren. Beispiele hierfür sind die Raumfahrt- und Automobilindustrie, der
Schiffbau und optische Industrien.

Durch Erzeugen von gleichungsgesteuerten Körpern müssen keine Techniken eingesetzt
werden, die zu Fehlern führen können, z. B. Schnittbearbeitung und Längsrichtung oder andere
nicht assoziative, annähernde Entwicklungstechniken.
Mithilfe des Befehls Körper durch Gleichung (Body by Equation) in Verbindung mit
konvergierende Konstruktion können Sie gleichungsgesteuerte Körper direkt in NX Konstruktion
verwenden. Dies führt zu einer verbesserten Genauigkeit und einer verringerten
Konstruktionszeit.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion

Vorraussetzung: Sie müssen über Zugriff auf Symbolica- oder Maple-Arbeitsblattdateien (.mw)
verfügen.

Befehlssuche: Körper durch Gleichung (Body by Equation), Symbolica (Symbolica)

3.2.2 Befehl, Werkzeug und Auswahl - Erweiterungen

3.2.2.1 Definieren von Druckmarken

Bei der Konstruktion eines Modells können Sie jetzt den Befehl Text (Text) verwenden, um Bereiche
als Druckmarken zu definieren, die bestimmen, wo Textmarkierungen, z. B. Seriennummern oder
Datumscodes, im späteren 3D-Druckvorgang angewendet werden sollen.

Das resultierende Druckmarke (Print Mark)-Textformelement kann ausgerichtet werden und hat ein
Attribut, mit dem es als spezieller dynamischer Text gekennzeichnet wird. Sie können Sternchen (*)
als Platzhalter für variablen Text verwenden, die in der Zeichenfolge während der additiven Fertigung
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durch einzelne Zeichen oder Ziffern ersetzt werden.

Druckmarken im Teile-Navigator

Das erzeugte Formelement zeigt im Teile-Navigator (Part Navigator) dieselben oder andere
Textformelemente an, ist aber nicht mit Text (Text), sondern mit Druckmarke (Print Mark)
bezeichnet.
Um zwischen Druckmarken zu unterscheiden, können Sie jeder eine eindeutige
Verwendungsbezeichnung (Usage Label) zuweisen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion, Fertigung

Vorraussetzung:
Legen Sie den Anwenderstandard Dialogelemente für additive
Fertigung in Konstruktionsbefehlen anzeigen (Show Additive
Manufacturing-specific Dialog Items in Modeling Commands) fest.

Befehlssuche: Text
Position im Dialogfenster: Gruppe Druckmarkeneinstellungen

3.2.2.2 Gitter - Erweiterungen

Der Befehl Gitter (Lattice) wurde wie folgt erweitert:

Sie können jetzt ein Gitter vom Typ Konformer Graph (Conformal Graph) erzeugen.

Ein Gitter vom Typ Konformer Graph (Conformal Lattice) weist die folgenden Eigenschaften auf:

Folgt der Kontur einer Fläche oder eines Flächenkörpers.
Kann von der ausgewählten Fläche oder dem ausgewählten Flächenkörper versetzt sein.
Kann aus mehreren Layern bestehen.



2025/07/07 04:28 12/36 3. Design

12/36 Printed on 2025/07/07 04:28

Wenn Sie ein Gitter vom Typ Einheitengraph (Unit Graph) erzeugen, können Sie jetzt Folgendes
ausführen:

Entfernen Sie mithilfe der neuen Option Nicht verbundene Gitterbereiche entfernen (Remove
Disconnected Lattice Potrions) kleine, nicht miteinander verbundene Gitterbereiche und
behalten Sie nur den größten Körper bei.

Entfernen Sie mithilfe der neuen Option Lose Stäbe an ausgewählten Flächen entfernen
(Remove Rods at Selected Faces) alle Stäbe aus dem Gittergraphen, die nur an einem Ende mit
dem Gitter verbunden sind und eine einzige der ausgewählten Flächen des Begrenzungskörpers
berühren.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion
Befehlssuche: Gitter

3.2.2.3 Konstruktionsunterstützung für mehrere Fenster

Die Anwendung Konstruktion wurde so erweitert, dass Sie fensterübergreifend effizienter arbeiten
können:

Rückgängig (Undo)/Wiederherstellen (Redo) – Die Befehle Rückgängig (Undo) und
Wiederherstellen (Redo) stehen auf allen Registerkarten einer Sitzung mit mehreren
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Anzeigeteilen zur Verfügung. Sie führen die richtige Aktion für das entsprechende Teil auf der
jeweiligen Registerkarte aus. Wenn Sie zwischen Registerkarten von Teilen umschalten und die
Anwendungen wechseln, rufen die Befehle Rückgängig (Undo) und Wiederherstellen (Redo)
weiterhin die entsprechende Registerkarte und die Befehlshistorie ab und führen die richtige
Aktion aus.
Anwendung wechseln – Wenn Sie zu einem anderen Fenster wechseln, startet NX automatisch
die Anwendung, die für das Teil ausgeführt wurde. Beispiel: Wenn Sie zu einem Fenster
wechseln, das eine Zeichnung enthält, startet NX automatisch die Anwendung
„Zeichnungserstellung“.
Auswählen von Objekten – Bei Verwendung eines Konstruktion-Befehls können Sie nur Objekte
im aktiven Fenster auswählen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion

3.2.2.4 Teile-Navigator - Erweiterungen

Wenn Sie fensterübergreifend mit verschiedenen Teilen arbeiten, behält der Teile-Navigator (Part
Navigator) jetzt die folgenden Einstellungen bei und zeigt sie für das jeweilige Teil an, sobald das
entsprechende Fenster aktiv wird:

Die Spaltensortierung
Der erweiterte oder reduzierte Zustand der Knoten
Die Bildlaufposition
Der Status Reihenfolge der Zeitstempel (Timestamp Order): Aktiviert oder deaktiviert
Die aktiven Filter

Die folgenden Einstellungen werden nicht für jedes Teil beibehalten und sind fensterübergreifend
identisch, bis sie geändert werden:

Eigenschaften von Teile-Navigator
Spaltenkonfiguration

Wann wird diese Funktion verwendet?

Beim Wechseln zwischen Teilefenstern behält der Teile-Navigator (Part Navigator) Ihren Zweck bei,
sodass Sie bei der Arbeit mit dem jeweiligen Teil einfach dort fortfahren können, wo Sie aufgehört
haben.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion, Shape Studio

3.2.2.5 Ausdrücke - Erweiterungen

Der Befehl Ausdrücke (Expressions) wurde um ein neues Fenster für Hilfe-Informationen am unteren
Rand des Dialogfensters erweitert. Wenn Sie eingebettete Funktionen auswählen, können Sie im
Fenster für Hilfe-Informationen bequem Beschreibungen der Funktion, die erforderlichen
Eingabeparameter und den Ausgabetyp anzeigen.
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Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion, Baugruppen

Vorraussetzung: Im Dialogfenster Ausdrücke (Expressions) muss eine eingebettete Funktion in
einer Zelle vom Typ Formel (Formula) vorhanden sein.

Befehlssuche: Ausdrücke

3.2.2.6 Schnittflächen - Erweiterungen

Der Befehl Schnittfläche (Section Surface) wurde so erweitert, dass beim Erstellen einer Schnittfläche
mit dem angegebenen Typ und Modus Folgendes gilt:

Typ Kegelförmig (Conic) mit dem Modus Rho (Rho) – Es werden keine übermäßigen
Oszillationen in der Führungsrichtung erzeugt, wenn die Option Entlang Führungen teilen (Split
Along Guides) ausgewählt ist.
Typ Kreisförmig (Circular) mit dem Modus Zwei-Punkte-Radius (Two Point Radius) – Sie können
jetzt alternative Lösungen erzeugen.
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Typ Kubisch (Cubic) mit dem Modus Verrundungsüberbrückung (Fillet Bridge) – NX fügt Pole nur
bei Bedarf hinzu, um die gewünschte Stetigkeit zu erreichen. Darüber hinaus werden den
definierenden Kanten der Oberfläche Handles hinzugefügt, sodass Sie die Oberfläche interaktiv
anpassen können. Im nachfolgenden Beispiel weist die Oberfläche auf der linken Seite die
Stetigkeit G1 (G1 ) auf beiden Seiten auf. Die Oberfläche auf der rechten Seite zeigt die
Polstruktur an, wenn Sie die Stetigkeit der rechten Seite in G2 (G2) ändern.

Typ Linear (Linear) mit dem Modus Spitzenwinkel (Point Angle) – Prozesse werden schneller
erstellt und aktualisiert.
Typ Kreisförmig (Circular) mit dem Modus Zwei-Punkte-Radius (Two Point Radius) – Es werden
weniger Pole erzeugt und die erzeugten Pole sind in gleichmäßigeren Abständen verteilt.

Wo kann diese Funktion aufgerufen werden?
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Anwendung: Konstruktion
Befehlssuche: Schnittflächen
Position im Dialogfenster: Gruppen Typ und Modus

3.2.2.7 Kurvenrichtung von Extrusionsschnitt

Verschiedene Befehle, die die Kurvenauswahl unterstützen, wurden wie folgt erweitert:

Die Option Richtung umkehren (Reverse Direction) wurde den Optionen zur Kurvenauswahl
hinzugefügt.
Wenn Sie eine Kurve auswählen, gibt im Grafikfenster ein Pfeil die Richtung der Schnittkurven
an. Sie können die Kurvenrichtung ändern, indem Sie auf den Pfeil doppelklicken oder im
Dialogfenster auf Richtung umkehren (Reverse Direction) klicken.

Wo kann diese Funktion aufgerufen werden?

Befehlssuche:

→Extrudieren
→Offset-Kurve
→Offset-Kurve in Fläche
→Kurve projizieren
→Schnittfläche
→Abweichende Extrusion

Position im Dialogfenster: Optionen zur Kurvenauswahl

3.2.2.8 Steuern von Verwindungen beim Abwickeln von Oberflächen

Es stehen neue Optionen zur Verfügung, mit denen Sie die Verwindung steuern können, die beim
Abwickeln bestimmter 3D-Oberflächen auftreten können.

Gruppe Zwangsbedingungen

Abwickeln mit (Flattening with) = Fixierte Elemente (Fixed Elements)

Sie können mit fixierten Elementen abwickeln, die Sie aus den Glättungsausgangsflächen auswählen.
Die fixierten Elemente bleiben während des Abwicklungsprozesses fixiert.
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Fixierte Elemente können einem der folgenden Objekttypen entsprechen:

Flächen
Kanten
Fangpunkte

Fixierte Elemente müssen sich auf einer gemeinsamen Ebene (koplanar) befinden und eine einzelne,
verbundene Komponente bilden (Punkte müssen nur koplanar sein).

Abwickeln mit (Flattening with) = Nichts
(None)

Reduzierte Verwindung beim Abwickeln mit
(Flattening with) = Fixierte Elemente (Fixed
Elements), wobei eine Fläche als fixiertes Element
ausgewählt ist.

Gruppe Kante

Ermöglicht Ihnen die Auswahl von Flächenkanten oder -kurven auf den Ausgangsflächen zur
Verwendung als Kante. Während des Abwicklungsprozesses werden die Ausgangsflächen entlang der
Kante und der Kurven „gebrochen“, um die Verwindung zu minimieren.

Abhängig von der zugrunde liegenden Geometrie können weiterhin Verwindungen auftreten.

Bei der Auswahl sind mehrere Kanten zulässig, unabhängig davon, ob sie verbunden sind.
Kanten müssen stets mit der Außenbegrenzung verbunden sein. Ein Konturzug intern
verbundener Kanten ist zulässig, wenn mindestens eine der zugehörigen Enden mit der
Außenbegrenzung verbunden ist.

Eine interne Kante ist nicht zulässig, wenn sie nicht in irgendeiner Art und Weise mit der
Außenbegrenzung verbunden ist (z. B. mit einer Spalte).

http://chriscomp.de/dokuwiki/lib/exe/fetch.php?media=nx1202_nx_design_040.png
http://chriscomp.de/dokuwiki/lib/exe/fetch.php?media=nx1202_nx_design_041.png
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Keine Kante (Rip Edges) ausgewählt Vier Kantenkonturzüge als Kante (Rip Edges) ausgewählt

Außenbegrenzung

Ermöglicht Ihnen die Angabe einer alternativen Außenbegrenzung für die Glättungsflächen. Sie sollten
eine Außenbegrenzung angeben, wenn Sie eine von mehreren Abwicklungsmöglichkeiten anwenden
möchten, die auftreten können, wenn Lücken oder Bohrungen in den Ausgangsflächen vorhanden
sind.

Standardmäßig ist die Außenbegrenzung die Kurven- oder Kantenbegrenzung mit der längsten Länge.

Gruppe Diagnose

Dem Dialogfenster wurde die neue Gruppe Diagnose (Diagnostics) hinzugefügt, die die vorhandenen
Optionen Distortion Map (Distortion Map) enthält.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktion, Shape Studio
Befehlssuche: Glätten und Formen

3.2.2.9 Löschen von untergeordneten Formelementen - Erweiterungen

Die Option Untergeordnete Formelemente löschen (Delete Child Features) wurde durch die neue
Einstellung Anfordern (Ask) erweitert, sodass Sie NX so einstellen können, dass jedes Mal nachgefragt
wird, ob untergeordnete Formelemente gelöscht werden sollen, wenn Sie ein Element löschen. In
früheren Versionen konnten Sie nur vorab Ja (Yes) oder Nein (No) für alle Löschungen von
untergeordneten Formelementen angeben. Sie konnten nicht auswählen, dass Sie jedes Mal gefragt
werden, wenn Sie ein Formelement löschen.

Sie können Untergeordnete Formelemente löschen (Delete Child Features) in Ihren
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Anwenderstandards oder in Ihren Konstruktion-Voreinstellungen auf Anfordern (Ask) festlegen. Die
Einstellung für den Anwenderstandard bestimmt die Standardeinstellung für diese Option in Ihren
Konstruktion-Voreinstellungen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Konstruktionsvoreinstellungen

Position im Dialogfenster: Registerkarte Bearbeiten → Liste Untergeordnete Formelemente
löschen

Löschen eines Ausgewählten Formelements:

Menü: Menü → Bearbeiten → Löschen

3.2.2.10 Produktschnittstelle - Erweiterungen

Sie können jetzt Produktschnittstellen direkt aus dem Teile-Navigator (Part Navigator) mithilfe der
neuen Kontextmenübefehle Anzeigen (Show), Ausblenden (Hide) und Neue Produktschnittstelle (New
Product Interface) anzeigen, ausblenden und erstellen.

3.2.2.11 Kurve optimieren

Die Standardeinstellung der Option Kurve optimieren (Optimize Curve), die in Anwenderstandards
(Customer Defaults) und Konstruktionsvoreinstellungen (Modeling Preferences) enthalten ist, wurde in
„Ein“ geändert.

Wo kann diese Funktion aufgerufen werden?

Befehlssuche: Konstruktionsvoreinstellungen → Anwenderstandards
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3.2.2.12 Warnungen zu fehlenden Referenzen

Legen Sie mithilfe der neuen Konstruktion-Voreinstellung Warnung bei fehlenden Referenzen (Warn
on Missing References) fest, ob Warnungen zu fehlenden Referenzen im Informationsfenster
Warnungs- und Fehlerbericht aktualisieren und als QuickInfos im Teile-Navigator (Part Navigator)
angezeigt werden.

Eine Referenz fehlt, wenn ein Objekt, von dem ein Formelement abhängig ist, unterdrückt wird oder
entfernt wurde.

Im folgenden Beispiel werden Warnungen zu einer fehlenden Referenzkante eines extrudierten
Formelements angezeigt.

Die Voreinstellung Warnung bei fehlenden Referenzen (Warn on Missing References) und die
vorhandene Voreinstellung Aktuelles Formelement bei Fehler erzeugen (Make Current Feature on
Error) ersetzen zusammen die Funktion des Dialogfensters Bearbeiten während der Aktualisierung
(Edit During Update) (EDU (EDU)), das nicht mehr verwendet wird.

Die Voreinstellung Warnung bei fehlenden Referenzen (Warn on Missing References) ist
standardmäßig deaktiviert. Es wird nicht empfohlen, sie zu verwenden, wenn Sie eine allgemeine
Volumenkörperkonstruktion durchführen.

Tipp:
Die Voreinstellung Warnung bei fehlenden Referenzen (Warn on Missing References) steht auch als
Anwenderstandard zur Verfügung.

Wann wird diese Funktion verwendet?

Sie können Warnungen zu fehlenden Referenzen erhalten, wenn Sie ein Modell aktualisieren.

Wo kann diese Funktion aufgerufen werden?
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Anwendung: Modeling, Shape Studio

Vorraussetzungen:

Zum Anzeigen von QuickInfos im Teile-Navigator (Part Navigator) muss
im Dialogfenster Anpassen (Customize) auf der Registerkarte
Symbole/QuickInfos (Icons/Tooltips) in der Gruppe QuickInfos (Tooltips)
das Kontrollkästchen QuickInfos zu Optionen in Dialogen anzeigen (Show
Tooltips on Dialog Options) aktiviert sein.
Um eine Aktualisierung oder eine Formelementwiedergabe eines Teils
bei Auftreten eines Fehlers zu stoppen und um das fehlerhafte
Formelement als aktuelles Formelement festzulegen, muss im
Dialogfenster Konstruktionsvoreinstellungen (Modeling Preferences) auf
der Registerkarte Aktualisieren (Update) das Kontrollkästchen Aktuelles
Formelement bei Fehler erzeugen (Make Current Feature on Error)
aktiviert werden.
Um einen Bericht zu Warnungen und Formelementfehlern während einer
Aktualisierung anzuzeigen, muss im Dialogfenster
Konstruktionsvoreinstellungen (Modeling Preferences) auf der
Registerkarte Aktualisieren (Update) das Kontrollkästchen Allgemeiner
Warn-/Fehlerbericht nach Aktualisierung (Generate Warning/Failure
Report after Update) aktiviert werden.

Befehlssuche: Konstruktionsvoreinstellungen
Position im
Dialogfenster:

Registerkarte Aktualisiere → Kontrollkästchen Warnung bei fehlenden
Referenzen

3.3. Baugruppen

3.3.1 Beibehalten von Komponenten, die in einer Modellansicht angezeigt
werden

Der Befehl Komponenten in der Ansicht anzeigen (Show Components in View) wurde um die neue
Option In Ansicht angezeigte Komponenten beibehalten (Maintain Components Shown in View)
erweitert, die es Ihnen ermöglicht, die Anzeige Ihrer aktuellen Modellansicht beibehalten zu können.
Wenn festgelegt ist, bleiben die angezeigten Komponenten erhalten, wenn Sie die Option festlegen,
und jede neue Komponente, die zur Baugruppe hinzugefügt wird, wird in dieser Modellansicht
automatisch ausgeblendet.

In anderen Modellansichten werden die neuen Komponenten, die Sie hinzufügen, weiterhin angezeigt.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Baugruppen

Anforderungen
Mindestens eine Komponente in Ihrer aktuellen Modellansicht muss
durch den Befehl Komponenten in der Ansicht ausblenden (Hide
Components in View) ausgeblendet sein.

Befehlssuche: Komponenten in der Ansicht anzeigen

Position im Dialogfenster: Gruppe Anzuzeigende Komponenten → Kontrollkästchen In Ansicht
angezeigte Komponenten beibehalten

3.3.2 Hinzufügen von Komponenten - Erweiterungen

Der Befehl Komponente hinzufügen (Add Component) wurde wie folgt erweitert, um den Workflow
zum Hinzufügen von Teilen zu Ihrer Baugruppe zu vereinfachen:

Mit der Option Komponentenanker (Component Anchor) können Sie jetzt benutzerdefinierte



2025/07/07 04:28 22/36 3. Design

22/36 Printed on 2025/07/07 04:28

Positionen zum Platzieren von Komponenten erstellen.
Mit der Option Baugruppenposition (Assembly Location) können Sie mithilfe der
Platzierungseinstellung Fangen (Snap) eine Fläche auf einer Baugruppe zum Platzieren einer
Komponente auswählen.
Die Dialogfensteroptionen Komponente verschieben (Move Component) und
Baugruppenzwangsbedingungen (Assembly Constraints) wurden in der Positionierungsgruppe
(Placement Group) integriert.
Die Komponentenvorschau kann zusätzlich zum Fenster Komponentenvorschau (Component
Preview) im Grafikfenster angezeigt werden.

Weitere Ankerpunkte

Wenn Sie in früheren Versionen von NX eine Komponente hinzugefügt haben, konnten Sie nur den
absoluten Ursprung als Ankerpunkt auswählen. Mithilfe des Befehls Produktschnittstelle (Product
Interface) können Sie jetzt weitere Punkte als auswählbare Ankerpunkte angeben. Dadurch erhalten
Sie eine höhere Flexibilität beim Hinzufügen von Komponenten in der Korrekturorientierung und
beschleunigen den Vorgang der Komponentenplatzierung.

Fangen von Komponenten auf Flächen

Platzieren Sie mithilfe der Einstellung Fangen (Snap) für die Baugruppenposition eine Komponente auf
vorhandenen Flächen in der Baugruppe. Dieser Vorgang ähnelt dem Erzeugen einer Skizze. Die
Position des Mauszeigers und die Orientierung der Baugruppe bestimmen die Fläche, auf der die
Komponente platziert wird, und die Orientierung der Komponente relativ zur Baugruppe.
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Platzierungsoptionen zum Verschieben und zum Definieren mit Zwangsbedingungen

Wenn Sie in früheren Versionen von NX nach der Auswahl eines Ursprungspunkts in einer Baugruppe
in der Gruppe Platzierung (Placement) auf Verschieben (Move) oder Nach Zwangsbedingungen (By
Constraints) geklickt haben, wurde das Dialogfenster Komponente verschieben (Move Component)
oder Baugruppenzwangsbedingungen (Assembly Constraints) geöffnet. Jetzt wurden die
Dialogfensteroptionen Komponente verschieben (Move Component) und
Baugruppenzwangsbedingungen (Assembly Constraints) in das Dialogfenster Komponente hinzufügen
(Add Component) integriert, sodass Sie Folgendes direkt aus dem Dialogfenster ausführen können:

Verwenden derselben Optionen aus Komponente verschieben (Move Component), um die
Komponente zu platzieren.
Auswählen und Erstellen von Zwangsbedingungstypen.
Entfernen aller Zwangsbedingungen durch Deaktivieren der Option Zwangsbedingungen
beibehalten (Keep Constraints) .

Diese Integration ermöglicht Ihnen den Zugriff auf andere Optionen zum Hinzufügen von
Komponenten, ohne die Zwangsbedingungen abbrechen zu müssen, die Sie für die zu platzierende
Komponente erstellt haben.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Baugruppen
Befehlssuche: Komponente hinzufügen

3.3.3 Ladeoptionen für Baugruppen- Erweiterungen

Der Befehl Ladeoptionen für Baugruppen (Assembly Load Options) wurde erweitert, um die Angabe zu
vereinfachen, wie eine Komponente geladen und angezeigt wird.

In der Gruppe Umfang (Scope) wurden die Kontrollkästchen Teilweises Laden (Use Partial Loading)
und Lightweight-Darstellungen verwenden (Use Lightweight Representations) durch die Liste Option
(Option) mit den folgenden Einstellungen ersetzt:

Vollständig geladen (Fully Load)
Teilweise geladen (Partially Load)
Vollständig geladen - Lightweight-Anzeige (Fully Load – Lightweight Display)
Teilweise geladen - Lightweight-Anzeige (Partially Load – Lightweight Display)

Wo kann diese Funktion aufgerufen werden?

Anwendung: Baugruppen
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Befehlssuche: Ladeoptionen für Baugruppen

Minimales Laden von Komponenten, die in Teamcenter gespeichert sind

Verwenden Sie die neue Option Minimal laden - Lightweight-Anzeige (Minimally Load - Lightweight
Display), um Baugruppenkomponenten mit Lightweight-Darstellungen zu laden und anzuzeigen. Bei
dieser Option werden weniger Daten geladen als bei der Option Teilweise laden - Lightweight-Anzeige
(Partially Load – Lightweight Display) und mehrere Prozessoren genutzt, um die Leistung beim Laden
zu verbessern. Die Baugruppe wird früh im Ladevorgang angezeigt, so dass Sie Ihre Szene einrichten
können, während die Komponenten geladen werden, z. B. Zoomen, Schwenken und Drehen der
Ansicht sowie Ausblenden oder Anzeigen von Komponenten.

Steuern des Ladestatus von Komponenten Wenn Sie die Option Minimal laden - Lightweight-
Anzeige (Minimally Load - Lightweight Display) verwenden, können Sie die Befehle Pause (Pause),
Wiedergeben (Play) und Beenden (Stop) verwenden, um das Laden von Komponenten anzuhalten,
fortzusetzen bzw. zu beenden. Die Steuerungsschaltflächen sind jetzt größer und werden zunächst in
der rechten unteren Ecke des aktiven Fensters angezeigt.

Wann wird diese Funktion verwendet? Minimales Laden von Komponenten erfordert weniger
Ladezeit als andere Ladeoptionen und ist nützlich, wenn Sie in Konstruktions-, Visualisierungs-,
Geometrieberechnungs- und Zeichnungserstellungsworkflows mit großen Baugruppen arbeiten.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Baugruppen

Vorraussetzungen:
Sie müssen Teamcenter Integration für NX verwenden und Komponenten aus
Teamcenter 11.3.0.1 a01_patch5, 11.4.0.5 oder einer höheren Version laden.
Diese Option funktioniert am besten, wenn Sie Komponenten laden, die in NX 9
oder höher gespeichert sind.

Befehlssuche: Ladeoptionen für Baugruppen
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3.3.4 Reflektieren von Komponenten

Wenn Sie sowohl eine linke als auch eine rechte Version einer Komponente benötigen, können Sie die
Komponente zur Baugruppe hinzufügen und dann reflektieren, um die andere Version zu erstellen.
Die reflektierte Komponente ist eine neue Instanz der ursprünglichen Komponente. Es wird keine neue
Teiledatei erstellt. Sie können auch Unterbaugruppen oder mehrere Komponenten reflektieren.

Bearbeiten einer reflektierten Komponente

Die reflektierten und die nicht reflektierten Komponenteninstanzen verweisen auf dieselbe Teiledatei,
so dass die Geometrie in allen Instanzen immer identisch ist. Da auf eine reflektierte Instanz eine
Reflexionstransformation angewendet wurde, ist die gesamte Geometrie in ihr reflektiert. Wenn Sie
die Geometrie in der ursprünglichen Komponente bearbeiten, werden die Änderungen sowohl in den
reflektierten und als auch in den nicht reflektierten Komponenteninstanzen angezeigt.

Da Sie eine reflektierte Komponenteninstanz nicht zum aktiven Teil machen können, können Sie die
Geometrie in der reflektierten Komponenteninstanz nicht direkt bearbeiten.

Vorbereiten von reflektierten Komponenten für nachfolgende Prozesse

Da eine reflektierte Komponente eine Instanz einer vorhandenen Komponente ist, müssen Sie
gewährleisten, dass nachfolgende Prozesse, einschließlich Fertigung, erkennen können, welche
Instanzen reflektiert und welche Instanzen nicht reflektiert sind. Sie können z. B. einer reflektierten
Komponente einen eindeutigen Komponentennamen zuweisen, wenn in den Prozessen Ihres
Unternehmens anhand von Komponentennamen zwischen reflektierten und nicht reflektierten
Instanzen unterschieden werden kann.

Wann wird diese Funktion verwendet?

Sie können eine reflektierte Komponente anstelle einer gespiegelten Komponente erstellen, wenn Sie
keine neue Teiledatei für die neue Komponenteninstanz erstellen möchten.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Baugruppen
Befehlssuche: Komponente reflektieren
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3.3.5 Baugruppen spiegeln - Erweiterungen

Wenn Sie eine Baugruppe spiegeln, können Sie nun auch den absoluten Ursprung der Baugruppe
spiegeln. In früheren Versionen wird für eine gespiegelte Baugruppe derselbe absolute Ursprung wie
für die Quellbaugruppe verwendet.

Ein gespiegelter absoluter Ursprung befindet sich in der gespiegelten Position, hat aber dieselbe
Orientierung wie der absolute Ursprung der Quelle.

Mit dem Anwenderstandard Position des absoluten Ursprungs spiegeln (Mirror Absolute Origin
Location) können Sie die Standardeinstellung der Option Position des absoluten Ursprungs aller
gespiegelten Baugruppen oder Komponenten spiegeln (Mirror the absolute origin location of all
mirrored assemblies or components) steuern.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Baugruppen
Befehlssuche: Baugruppe spiegeln

Position im Dialogfenster:
Assistent: Baugruppen spiegeln → Seite Ebene auswählen → Position
des absoluten Ursprungs aller gespiegelten Baugruppen oder
Komponenten spiegeln

3.3.6 Sortieren im Baugruppen-Navigator nach Datentyp

Wenn Sie Daten im Baugruppen-Navigator (Assembly Navigator) sortieren, indem Sie auf die Spalte
Berichteigenschaft (Report Property) klicken, sortiert NX die Daten jetzt anhand ihres Datentyps, z. B.
alphanumerische Sortierung für Zeichenfolgen, numerische Sortierung für Zahlen oder
Datumssortierung für Datumsangaben.

Bisher wurden Daten in der Spalte Berichteigenschaft (Report Property) alphabetisch sortiert.

Wo kann diese Funktion aufgerufen werden?
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Anwendung: Baugruppen

Vorraussetzungen: Das HD3D-Werkzeug Visuelle Berichterstellung (Visual Reporting) muss
aktiviert sein.

Baugruppen-Navigator: Spalte Berichteigenschaft .

3.4. Zeichnungserstellung

3.4.1 Unterstützung der Zeichnungserstellung für die Anzeige von mehreren
Teilen

Sie können jetzt mehrere Registerkartenfenster bei der Arbeit mit Zeichnungen und Master-Teilen
öffnen und diese separat oder alle gleichzeitig in organisierten Gruppen anzeigen.

Mithilfe von Registerkartenfenstern können Sie Folgendes ausführen:

Gleichzeitiges Arbeiten in dem Master-Modell und der Zeichnung, ohne das angezeigte Teil
wechseln zu müssen.
Arbeiten in bestimmten Blättern in mehreren Zeichnungen. Dies kann der Fall sein, wenn Sie
Zeichnungstestunterlagen erstellen oder Zeichnungsunterschiede zwischen mehreren
Änderungsständen desselben Teils darstellen möchten.
Schnelles Ausschneiden, Kopieren und Einfügen von Objekten zwischen Zeichnungen.
Visualisieren der Auswirkung von Änderungen des benutzerdefiniertes Master-Symbols in
Zeichnungen, die Instanzen des Master-Symbols enthalten.

Bei der Arbeit in einer erweiterten Zeichnungsansicht müssen Sie zunächst die Erweiterung der
Ansicht aufheben, bevor Sie in ein anderes Fenster wechseln können.

Wann wird diese Funktion verwendet?

Sie können gleichzeitig im Master-Modell und im Nicht Master-Zeichnungsteil arbeiten. Dies ist
besonders nützlich, wenn Sie Unterschiede in der Zeichnung sofort anzeigen und abgleichen möchten,
die durch Änderungen im 3D-Modell verursacht wurden.

Wo kann diese Funktion aufgerufen werden?
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Für weitere Informationen zum Anzeigen von und Arbeiten mit mehreren Teilen in derselben NX-
Sitzung finden Sie unter Anzeigen von Konstruktionen in mehreren Fenstern.

3.4.2 Zeichnungserstellung-Unterstützung für minimal geladene Baugruppen

Die Anwendung „Zeichnungserstellung“ unterstützt die Verwendung der neuen Ladeoption Minimal
laden - Lightweight-Anzeige (Minimal Load – Lightweight Display), die eine schnelle Lightweight-
Ladeoption ab NX 12.0.2 darstellt.

Wenn Sie diese Option verwenden, werden nur Volumenkörper im aktiven Reference Set geladen und
als facettierte Geometrie angezeigt. Alle anderen Teilegeometrien und Teileattribute sowie alle nicht
aktiven Reference Sets und Komponenten bleiben ungeladen, bis Sie diese manuell laden. Dies kann
sich auf die Anzeige Ihrer Zeichnung auswirken.

Weitere Informationen hierzu finden Sie unter Auswirkungen der Ladeoptionen für Baugruppen in
Zeichnungen.

Wann wird diese Funktion verwendet?

Verwenden Sie die Ladeoption Minimal laden - Lightweight-Anzeige, wenn Sie eine sehr große
Baugruppe, die aus Tausenden von Komponenten besteht, effizienter und schneller laden möchten.

Wo kann diese Funktion aufgerufen werden?

Befehlssuche: Ladeoptionen für Baugruppen

Position im Dialogfenster: Gruppe Umfang (Scope) → Liste Option → Minimal laden - Lightweight-
Anzeige

3.4.3 Verbesserung bei Form- und Lagetoleranzen

Der Befehl Toleranzrahmen (Feature Control Frame) wurde mit neuen Optionen für Indikator
(Indicator) so erweitert, dass Sie einzelnen Toleranzrahmen die folgenden Indikatoren hinzufügen
können:
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Anzeige Sammlungsebene Anzeige Richtungsformelement

Anzeige Schnittebene Anzeige Orientierungsebene

Wann wird diese Funktion verwendet?

Sie können Ihrem Teil die neuesten standardkonformen Form- und Lagetoleranzen hinzufügen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Zeichnungserstellung und PMI

Vorraussetzungen: Sie müssen den Anwenderstandard Indikatorgruppe anzeigen
festlegen.

Befehlssuche: Form-/Lagetoleranzrahmen
Position im Dialogfenster: Gruppe Rahmen → Untergruppe Indikator → Liste Typ

3.4.4 Ungleich verteilter Toleranzen-Modifikationsfaktor in Form- /
Lagetoleranzen

Der Befehl Form-/Lagetoleranzrahmen (Feature Control Frame) wurde um die neue Option UZ (UZ)
erweitert, die eine ungleichmäßig verteilte Toleranzzone angibt.
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Wann wird diese Funktion verwendet?

Sie können „Form/Lage“, das zu den neuesten ISO- und DIN-Normen kompatibel ist, zu einem Teil
hinzufügen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Zeichnungserstellung und PMI
Befehlssuche: Form-/Lagetoleranzrahmen

Position im Dialogfenster: Gruppe Rahmen (Frame) → Untergruppe Toleranz → Untergruppe
Toleranz-Modifikationsfaktor → Kontrollkästchen UZ

3.4.5 Winkelbemaßung

Der Befehl Winkelbemaßung (Angular Dimension) wurde durch den Bemaßungstyp Ausgerichtet
(Directed) so erweitert, dass Sie nach Winkel gerichtete Bemaßungen erzeugen können. Bei einer
gerichteten Bemaßung handelt es sich um eine Bemaßung, die die Richtung einer Messung angibt,
und bei der die gesamte Toleranz auf das zweite Objekt angewendet wird.

Wann wird diese Funktion verwendet?

Sie können zusätzliche Konstruktionsinformationen erfassen, wenn Sie die Formelemente in Ihrem
Modell bemaßen. Z. B. können die Informationen, die von einer nach Winkel gerichteten PMI-
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Bemaßung erfasst wurden, in nachgeschalteten Anwendungen wie Toleranzanalysen und
Prüfanwendungen verwendet werden.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Zeichnungserstellung und PMI

Vorraussetzungen: Sie müssen die Zeichnungsvoreinstellung Gerichtete Bemaßungen
aktivieren festlegen, bevor Sie die Bemaßung erzeugen.

Befehlssuche: Winkelbemaßung
Position im Dialogfenster: Gruppe Referenzen → Liste Bemaßungstyp → Ausgerichtet

3.4.6 Bemaßung und Beschriftung - Erweiterungen

Option Durchgangsbohrungstext

Sie können die Textzeichenfolge angeben, die die
Tiefe in einem Bohrungs-Callout für eine
Durchgangsbohrung darstellt.
Der mit Ihrem Teil verknüpfte Standard für
Zeichnungserstellung (Drafting Standard), z. B.
ESKD (1), JIS (2), ASME (3) und ISO (4), bestimmt, ob
eine Standardtextzeichenfolge für die Voreinstellung
vorhanden ist.

Voreinstellung Null bei Grundlinie anzeigen

Sie können automatisch Null bei
Ordinatenbemaßungsgrundlinien anzeigen.

Voreinstellung Bemaßungslinie zentrieren

Sie können eine duale Bemaßung auf der
Bemaßungslinie vertikal zentrieren.
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3.4.7 Begrenzungs- und Einpasstoleranzen für Bohrungs- und
Gewindecallouts

Sie können jetzt Begrenzungs- und Einpasstoleranzen auf Callouts für Folgendes anwenden:

Die Durchmesser von allgemeinen, Bohrergröße- und Schraubenfreiraumbohrungen.
Die Innen-, Außen- und Gewindebohrdurchmesser von Gewindebohrungen.
Die Innen- und Außendurchmesser, Vorbohrdurchmesser und Schaftgrößen von symbolischen
Innen- und Außengewinden.

Wenn Sie eine Begrenzungs- und Einpasstoleranz auf einen Bohrungs-Callout anwenden, wird die
gesamte Bemaßung darüber oder innen mit der Bemaßungslinie angezeigt. Sie können die Einstellung
Nach Bemaßungslinie teilen (Split by Dimension Line) nicht auf die Bemaßung anwenden, um zu
erreichen, dass sie sowohl oberhalb als auch unterhalb der Bemaßungslinie angezeigt wird.

Wann wird diese Funktion verwendet?

Sie können unterstützte Bohrungstypen, die eine Begrenzungs- und Einpasstoleranz erfordern,
ordnungsgemäß bemaßen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Zeichnungserstellung und PMI

Grafikfenster:
Beim Erzeugen oder Bearbeiten eines Bohrungs-Callouts → Feld für
Bemaßungsformat → Bemaßungstypliste → Durchmesser, Durchmesser bei
Flachsenkung oder Kegelsenkungs-Durchmesser → Toleranztypliste → Begrenzungen
und Einpassungen

3.4.8 Bohrungs-Callouts mit doppelter Bemaßung

Sie können nun Callouts mit doppelter Bemaßung erstellen für:

Die Durchmesser und Tiefenparameter von allgemeinen, Bohrergröße- und
Schraubenfreiraumbohrungen.
Die Durchmesser, Tiefe, Gewindetiefe und Steigungsparameter der Gewindebohrungen.
Die Durchmesser, Steigung, Länge, den Vorbohrdurchmesser und Schaftgrößen von
symbolischen Innen- und Außengewinden.
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Wenn Sie eine Bohrungsbemaßung erstellen oder bearbeiten, können Sie die Option Duale Bemaßung
anzeigen (Show Dual Dimension) für alle unterstützten Parameter der Bohrungsabmessung festlegen.
Präfix (Durchmessersymbol) und Suffix (Tiefentext) für einen Bohrungsdurchmesser werden nur für
die primären Parameter der Bemaßung angezeigt.

Wann wird diese Funktion verwendet?

Sie können Bohrungstypen, die ein doppeltes Bemaßungsformat benötigen, richtig dimensionieren.

Wo kann diese Funktion aufgerufen werden?

Erzeugen und Bearbeiten eines Bohrungs-Callouts

Anwendung: Zeichnungserstellung und PMI

Grafikfenster:
Wählen Sie beim Erstellen oder Bearbeiten eines Bohrungs-Callouts den
Szenendialog → Bemaßungstypliste → Durchmesser, Tiefe, Durchmesser bei
Flachsenkung → Tiefe der Flachsenkung, Durchmesser der Kegelsenkung,
Tiefe der Kegelsenkung oder Länge → klicken Sie auf Texteinstellungen

Position im
Dialogfenster:

Dialogfenster Texteinstellungen → Knoten Doppelt → Gruppe Format →
Kontrollkästchen Duale Bemaßung anzeigen

3.4.9 Sprechblasenform - Erweiterungen

Sie haben jetzt größere Kontrolle über die Formen von Sprechblasensymbolen. Sie haben folgende
Möglichkeiten:

Sie können die vorhandene Form eines oder mehrerer Sprechblasensymbole bearbeiten.
Sie können die standardmäßige Sprechblasenform festlegen.
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Wo kann diese Funktion aufgerufen werden?

Bearbeiten der Form eines vorhandenen Sprechblasensymbols

Anwendung: Zeichnungserstellung
Grafikfenster: Doppelklicken auf ein vorhandenes Sprechblasensymbol
Position im Dialogfenster: Typliste

3.4.10 Unterstützung für Modellpunkte in Zeichnungsansicht

Die Zeichnungserstellung-Voreinstellung Modellkurven einschließen (Include Model Curves) wurde so
erweitert, dass mit dem Modell verknüpfte Konstruktionspunkte extrahiert und in den
Zeichnungsansichten Exakt (Exact) und Intelligentes Lightweight (Smart Lightweight) dauerhaft
angezeigt werden. Die Konstruktionspunkte müssen im Reference Set enthalten sein, das zur
Erstellung der Zeichnungsansicht verwendet wird.

Konstruktionspunkte im Reference Set, das zur Erstellung einer Zeichnung verwendet wird, sind jetzt
dauerhafte Objekte in den Zeichnungsansichten Exakt (Exact) und Intelligentes Lightweight (Smart
Lightweight). Wenn die Master-Modell-Geometrie in der NX-Sitzung entladen oder nicht geladen ist,
werden die mit den Konstruktionspunkten verknüpften Beschriftungen und Bemaßungen nicht als
beibehalten angezeigt.
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Wann wird diese Funktion verwendet? Sie können Konstruktionspunkte schnell extrahieren, um
sinnvolle Bereiche in einer Zeichnungsansicht anzugeben, ohne die verknüpfte Modellgeometrie
speziell laden zu müssen. Sie können z. B. die Mitte einer großen Anzahl von Bohrungen angeben
oder Bereiche auf dem Modell identifizieren, um wichtige Fertigungsinformationen zuzuordnen.

Wo kann diese Funktion aufgerufen werden?

Anwendung: Zeichnungserstellung

Vorraussetzung: Die Punkte müssen im Referenz Set enthalten sein, das in der Zeichnungsansicht
verwendet wird.

3.4.11 Schnittkomponenten - Erweiterungen

Die Funktion der Schnittkomponente wurde wie folgt erweitert:

Sie können jetzt jede beliebige Kombination aus Groß- und Kleinbuchstaben verwenden, wenn Sie
einer Komponente, einer Teileinstanz oder einem Objekt im Teil das Attribut SECTION-COMPONENT
(SECTION-COMPONENT) hinzufügen. In früheren Versionen wurde das Attribut von NX ignoriert, wenn
im Attributnamen eine Kombination aus Groß- und Kleinbuchstaben verwendet wurde.

Wenn das Attribut SECTION-COMPONENT (SECTION-COMPONENT) für ein Objekt geändert wird,
werden alle Zeichnungsansichten, die das Objekt enthalten, als veraltet gekennzeichnet.

In früheren Versionen wurden entsprechende Zeichnungsansichten nicht immer als veraltet
gekennzeichnet.

Weitere Informationen zu Schnittobjekten in Schnittansichten der Zeichnungserstellung finden Sie in
der Zeichnungserstellung-Hilfe im Abschnitt zum Thema Schnittkomponentenattribut.

Wo kann diese Funktion aufgerufen werden?

Festlegen des Attributs für ein bestimmtes Teil

Anwendung: Alle NX Anwendungen
Menübandleiste: Registerkarte Datei (File) → Eigenschaften (Properties)
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Befehlssuche: Angezeigte Teileeigenschaften (Displayed Part Properties)

Menü:
Im Dialogfenster Angezeigte Teileeigenschaften (Displayed Part
Properties) auf der Registerkarte Attribute (Attributes) in der Gruppe
Kontext (Context) muss Interaktionsmethode (Interaction Method) auf
Traditionell (Traditional) festgelegt sein.

Position im
Dialogfenster:

Gruppe Teileattribute (Part Attributes) → Knoten DB-Komponenteninstanz
(DB Component Instance) → SECTION-COMPONENT (SECTION-
COMPONENT)
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